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1 INTRODUCTION  
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1.1 ABOUT 

ArCADia-DISTRIBUTION BOARDS is an intelligent tool extending the ArCADia-INTELLICAD/AutoCAD 

software with the features necessary to create single line diagrams and electrical views. The software 

is addressed to designers of networks, installations of electrical and power networks, as well as to 

anyone associated with the electro-technical industry. The ArCADia-DISTRIBUTION BOARDS program 

can be used to create diagrams of an electric distribution board or any electrical diagram, perform 

basic technical calculations and generate a real view of the designed distribution board. The user may 

also employ the database of electric device symbols used when designing, along with an option to edit 

the objects and add technical parameters to them. Apart from the possibility to quickly and easily 

design a distribution board diagram, the program can also be used to automatically create a 

distribution board diagram designed using the ArCADia-ELECTRICAL INSTALLATIONS overlay. The 

combination of electric diagram creation algorithms used in the application together with the database 

of electric device symbols and the possibility to perform basic calculations provides a perfect tool for 

electric system designers. 

1.2 FEATURES AND FUNCTIONALITIES OF THE PROGRAM 

The technical scope of functionalities provided by the software and its basic functions: 

 Quick and efficient designing of single line schematic diagrams of electric distribution boards, 

 Possibility to create control systems, 

 Possibility to perform basic technical calculations (load current, voltage drop, load power, power 

balance), 

 Automatic generation of a distribution board diagram designed using the ArCADia-ELECTRICAL 

INSTALLATIONS overlay, 

 Database of electric devices and instruments, 

 Generating quantity lists for materials used in the project, 

 Generating real views of electric distribution boards, 

 Possibility to design enclosures for electric distribution boards. 

 

All calculations and the verifications carried out by ArCADia-DISTRIBUTION BOARDS were developed 

based on the following standards, regulations and scientific and technical publications: 

 

[1] Electric product catalogues of the following manufacturers: Legrand, Apator, Relpol, Eti, 

Moeller. 

 

[2] PN-EN 60617-3:2003 Graphic symbols used in diagrams. Part 2: Symbol elements, 

distinguishing symbols and other general purpose symbols. 
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[3] PN-IEC 60364-4-41 "Electric installations in buildings. Protection for safety. Protection against 

electric shock". 

 

[4] PN-EN 60617-11:2004 Graphic symbols used in diagrams. Part 11: Architectural and 

topographical plans and diagrams of electric installations. 

 

[5] Markiewicz H. "Instalacje Elektryczne, Wydanie szóste" Wydawnictwo Naukowo-Techniczne, 

Warsaw 2005 

 

[6] Wiatr J. "PORADNIK PROJEKTANTA ELEKTRYKA – Podstawy zasilania budynków mieszkalnych, 

użyteczności publicznej i innych obiektów nieprzemysłowych w energię elektryczną" 

 

[7] PN-EN 60439-1:2002 (U) Low-voltage switchgear and controlgear assemblies – Type-tested 

and partially type-tested assemblies. 
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2 INSTALLING AND RUNNING THE PROGRAM 
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2.1 HARDWARE REQUIREMENTS 

 Procesor Intel Core 2 Duo lub AMD Athlon II (recommended min. Intel Core i5-6500) 

 3 GB RAM (recommended min. 12 GB and system 64-bit) 

 5 GB of free HDD space (recommended SSD) 

 For standard 3D view  graphics card compatible with DirectX 9.0c 1GB RAM,  
for advanced 3D view graphics card compatible with DirectX 11 and min. 3GB RAM 

 Windows 10 , Windows 8.1 , Windows 7 SP1 (recommended Windows 10 64-bit) 

2.2 INSTALLATION 

The program installation starts automatically when the CD is inserted into the drive. The installation 

should be started manually if the Autostart function is disabled. Open the CD content (Computer/CD 

drive), and run the Setup.exe file from the program folder. Once the installation is started, proceed 

according to instructions displayed on the screen. 

2.3 RUNNING 

The software may be started by double-clicking on the CAD program icon located on the desktop and 

then selecting one of the icons on the ArCADia-DISTRIBUTION BOARDS toolbar. 

2.4 OPENING A PROJECT (CAD) 

Any of the following file types may be opened: 

 Standard DWG drawing file.  

 Any of the following sample drawings supplied with the ArCADia-INTELLICAD software may be 

used.  

 DXF drawing exchange file.  

 DWF network transmission file.  

 DWT drawing template file.  

 

In order to quickly access the last edited drawing choose File > <file name>. The software stores the 

names of the last four drawings. In order to quickly access a drawing from the Open drawing dialogue 

box, double-click the drawing name. 

A drawing may be opened when browsing drawings on the computer using e.g. Windows Explorer. All 

you need to do to open the drawing in ArCADia-INTELLICAD is to double-click the file. Thumbnails 

displayed when browsing help identify the drawing you need. 
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Opening an existing drawing 

1. Use one of the following methods: 

 Choose File > Open. 

 On the Standard toolbar select the Open ( ) tool. 

 Write open and then press Enter.  

2. Choose the type of the file you want to open from file type.  

3. Choose the folder that contains the selected drawing.  

4. Do one of the following:  

 Choose the drawing that you want to open and click Open.  

 Double-click the drawing you want to open.  

If the drawing requires a password, provide the password, then click OK to verify the password and 

then click Open again. 

2.5 SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing, use one of the following methods: 

 On the Standard toolbar click Save. 

 Choose File > Save. 

 Write save and then press Enter. 

 Type qsave and then press Enter. 

 

When you save a particular drawing for the first time, the system will display a dialogue box Save 

drawing as, which allows you to select a folder and provide a name for the drawing. You can use any 

name when saving the drawing for the first time. In order to save the same drawing under a different 

name later, select File > Save as and then type in the new name. 

2.6 AUTOSAVE AND BACK-UP COPY (CAD) 

In order to avoid data loss in case of a power outage or another system error, it is necessary to save 

your drawing files often. The software may be configured to periodically save your drawings 

automatically. The Autosave setting determines the interval in minutes between automatic saves. The 

software resets this interval each time the user saves a drawing file. 
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When the Autosave feature is activated, the software creates copies of the drawing. These files are 

automatically saved to the folder provide under Options > Paths/Files > Temporary file and given the 

extension indicated in the Drawing autosave file extension (SV$ by default). 

 

Configuring ArCADia-INTELLICAD to automatically save drawings 

1. Do one of the following: 

 Select Tools > Options. 

 Write config and then press Enter. 

2. Click the General tab. 

3. In the Autosave area select one of the check boxes in order to enable the Autosave feature 

and select the autosave frequency. 

4. Click OK. 
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3 WORKING WITH THE SOFTWARE 
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3.1 BASIC SOFTWARE INFORMATION 

ArCADia-DISTRIBUTION BOARDS can be used to design diagrams and views of electric distribution 

boards. As a diagram and view of a cabinet is designed, the process is as follows: 

1. The work with the program is commenced by defining a layout of a power supply system and 

parameters of rails. A diagram is designed by locating and characterising the first instrument 

located on the diagram. Its basic features and parameters are defined and a grid is inserted to 

assist the designing process. 

2. Columns of the assist grid are divided into: power supply, overvoltage protection and outgoing. 

All columns of the designed diagram can be defined using the project properties. 

3. The next step of the diagram designing is to define an overvoltage protection and outgoing 

circuits of the distribution board by inserting overvoltage and protection devices.  

4. Then, it is necessary to define cells in the table, describe designed circuits and assign technical 

parameters to them. 

5. Once the parameters are introduced (voltage, power, cross-section and length), the user may 

then calculate load currents and voltage drops in the designed circuits. 

6. A schematic diagram of the distribution board can be drawn in two ways: using automatic 

connections between rails and devices or using the "electrical connection line", which can be 

used to create individual connections between devices. A connection method can be defined 

for each item and the diagram can be drawn. 

7. Once the schematic diagram of a distribution board is designed, we can generate the list of 

devices and materials used in the design to cost-estimate the project.  

8. The program can be used to generate a real view of your distribution board.  

First, the designer defines parameters and type of the distribution board, creates the 

appearance of the designed board, and then orders devices inside. 

9. The user can display the front side of the designed distribution board accounting for devices 

installed on the front door of the box. 

 

The description of the program interface 

ArCADia-DISTRIBUTION BOARDS adds its own tools to the ArCADia-INTELLICAD/AutoCAD menu, as 

described in the table below: 

 

 

Rys. 1. The ArCADia-DISTRIBUTION BOARDS toolbar 
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*BIM – options available to ArCADia BIM license holders, i.e. after purchasing one of the following 

programs: ArCADia, ArCADia AC, ArCADia LT or ArCADia PLUS. 

 

Functions of the ArCADia-DISTRIBUTION BOARDS toolbar: 

Icon Function Description *BIM 

 

Show/Hide Project 

Manager 

Displays or hides the level management 

window. 
Χ 

 

Insert circuit 

breaker 

Inserts the symbol of a circuit breaker along 

with a description. 
Χ 

 
Insert load switch  

Inserts the symbol of a load switch along with 

a description. 
Χ 

 
Insert arrester 

Inserts the symbol of an arrester along with a 

description. 
Χ 

 
Insert contactor 

Inserts the symbol of a contactor along with 

a description. 
Χ 

 
Insert switch 

Inserts the symbol of a switch along with a 

description. 
Χ 

 
Insert programmer 

Inserts the symbol of a programmer along with 

a description. 
Χ 

 
Insert relay  

Inserts the symbol of a relay along with a 

description. 
Χ 

 
Insert controller 

Inserts the symbol of a controller along with 

a description. 
Χ 

 
Insert transformer 

Inserts the symbol of a transformer along with 

a description. 
Χ 

 

Insert power supply 

unit 

Inserts the symbol of a power supply unit along 

with a description. 
Χ 

 
Insert sensors 

Inserts the symbol of a sensor along with a 

description. 
Χ 



ArCADia-DISTRIBUTION BOARDS User Manual 

Working with the software 

 

14 

 
Insert signalling 

Inserts the symbol of a signalling device along 

with a description. 
Χ 

 
Insert analyser 

Inserts the symbol of an analyser along with 

a description. 
Χ 

 

Insert electrical 

energy meter 

Inserts the symbol of an electrical energy meter 

along with a description. 
Χ 

 

Insert current 

transformer 

Inserts the symbol of a current transformer 

along with a description. 
Χ 

 Insert voltmeter 
Inserts the symbol of a voltmeter along with 

a description. 
Χ 

 Insert ammeter 
Inserts the symbol of an ammeter along with 

a description. 
Χ 

 
Insert socket 

Inserts the symbol of a socket along with a 

description. 
Χ 

 
Insert fuse 

Inserts the symbol of a fuse along with a 

description. 
Χ 

 
Insert inverter 

Inserts the symbol of an inverter along with a 

description. 
Χ 

 
Insert Soft start 

Inserts the symbol of a soft start along with a 

description. 
Χ 

 
Insert front view 

Insert a real view of a box along with a 

description 
Χ 

 
Insert box Inserts a new distribution board design  Χ 

 

Generate material 

list 

Generates quantitative lists of materials used in 

the project. 
Χ 

 

Insert electrical 

connection line 

Make it possible to create electrical 

connections between items. 
Χ 
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Program option 

settings 

Enables the use of standard options for the 

entire project. 
Χ 

 
Show help Displays the help window. Χ 

 

 

 

 

 

Once an item is clicked, the following tool bar is shown on the model: 

a) Circuit breaker  

 

 

3.1.1 General software options 

After entering the general options of the ArCADia-DISTRIBUTION BOARDS program, the dialogue 

window is displayed with the following program options: 

 

 

Rys. 2. Software option window 
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A custom scale can be introduced for all items made available by the ArCADia-DISTRIBUTION BOARDS 

program using the "Options" window. The designer can specify the value of aluminium and copper 

conductivity assumed for technical calculations performed by the program.  

 

Once the electric diagram of the distribution board is defined and specific parameters are set to 

outgoing connections, the ArCADia-DISTRIBUTION BOARDS performs standard calculations: 

 calculation of load currents (1-phase or 3-phase) for individual circuits of the system, once the 

parameters of power, voltage and simultaneity, and demand factors are defined, 

 calculation of load power, 

 calculation of voltage drops in each circuit, once the parameters of power, voltage, cable cross-section, 

length and material are defined, 

 calculation of power balance of the designed switchgear. 

 

Results of technical calculations are shown by the ArCADia-DISTRIBUTION BOARDS in the table cells 

under the diagram. All electrical values are specified in the table, therefore the user has a complete 

picture of the designed switchgear. The user can generate a calculation report.  

Values and parameters of circuits are defined in the properties of the distribution board: 

 

Rys. 3. The table cell management window 
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Rys. 4. The power supply circuit properties 

 

Rys. 5. The outgoing circuit properties 

Name – the user sets a name for a given diagram columns, e.g. Circuit gn.1-phase 

Terminals – the user sets marking of terminal (phases), which given circuits are connected to. 
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Phase design – the user determines power supply voltage of the consumer (400 V – three phase, 230 V 

– single phase). Determining the phase design enables calculating the load currents for the consumers, 

 

Technical calculations are begun from calculating the load power P0: 

ZIO kPP   

 

The values of demand factors are defined in the circuit properties in order to calculate the peak power 

demand (active), which occurs in the designed outgoing electrical circuit. In addition, the simultaneity 

factor is present in the "incoming feeder" properties in order to calculate the peak power demand, 

which occurs in the designed power supply line.  

 

Demand factor kz is the peak power demand P0 (design power) to installed power Pi ratio: 

(1) 
i

z
P

P
k 0  

 

Simultaneity factor kj is the ratio of the peak power of the indoor power supply line supplying the 

distribution board to the total of the peak powers of all the circuits output from the distribution board:  

(2) 








n

i

si

Owlz

OnOOO

wlz
j

P

P

PPPP

P
k

1

321

0

...

 

 

Once the designer determines the demand factor and simultaneity factor values, the program 

calculates the peak power values as per the formulas (1) and (2). 

 

Once load power [kW] calculations are completed, the program calculates the load current [A] that 

will be present in the distribution board power supply line and in all the circuits output from the 

switchgear.  

If the user defines a single phase design in the circuit properties, the program will use the formula (4). 

If this is a three-phase design, we use the formula (3). The phase configuration of the consumer may 

be defined both in the consumer item (socket), as well as in the distribution board. 

 

I0 – load current present in the designed power supply  

(3) 
cos3

0




N

o
U

P
I  – three-phase load current present in a particular circuit, 

where: 
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P0  — design power [Po = kz*Pi], 

UN  — 400 [V] line-to-line voltage, 

cos φ  — power factor input by the user in the "distribution board" item. 

 

(4) 
cos

0




Nf

o
U

P
I  – single-phase load current present in a specific circuit. 

where:  

UNf  – 230 [V] phase voltage. 

 

 power factor cos φ — this is the ratio of the consumer’s active power to its apparent power. The power 

factor value is determined depending on the type of the consumer (resistance, induction, capacity). If 

cos φ = 1 then we are dealing with pure resistance, if cos φ = 0, we are dealing with pure inductance or 

capacity. The designer should assume to what extent the designed consumer uses reactive power and 

whether he will limit this power by means of any installed compensation devices. 

 

Type – the user specifies a wire type, e.g. YDY, DY, LgY, YKY, YKXs. 

 

Conductor metal – suitable electricity conductors are usually aluminium or copper. Aluminium is 

characterised by lower electric conductivity than copper 

(γAl = 35 
2mm

m


, γCu = 55 

2mm

m


). 

 

The next step in the calculations carried out by ArCADia-DISTRIBUTION BOARDS concerns voltage 

drops in a specific circuit. To this end the software uses the following formulae: 

 

Voltage drop formula for three-phase circuits: 

(5) 21%
**

**100

N

o
L

Us

lP
U




 

Voltage drop formula for single-phase circuits: 

(6) 
21%

**

**200

Nf

o
L

Us

lP
U




 

where: 

s –  conductor cross-section (this parameter is to be input by the designer), 
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γ –  conductor conductivity: 

γ = 35 [m/(Ω*mm2)] for aluminium, 

γ = 55 [m/(Ω*mm2)] for copper, 

l –  length of the designed circuit [m], 

Po – load power of the circuit [W], 

UNf – phase voltage, i.e. 230 V, 

UN – line-to-line voltage, i.e. 400 V. 

 

The program sums up installed power and load power of outgoing circuits as well as load 

current in the "Power Supply" column.  

3.2 DESCRIPTION OF ITEMS 

3.2.1  Diagram of the distribution board 

When a diagram is "double-clicked" or selected and the properties dialogue box is entered, the 

following window is displayed: 

 

Rys. 6. The diagram properties window 

The following features can be defined in the "appearance" field: 

- dimming of the diagram grid, table and electrical connection points (nodes), 

- parameter content in the table. 

 

When the "distribution board properties" button is clicked, the designer can define type, name and 

properties of circuits in the diagram.  
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Rys. 7. The table cell management window 
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When properties of a specific circuit are clicked, the following window is open: 

 

Rys. 8. The table cell management window 

The user defines a "name" of the circuit, e.g. "electric cooker circuit". Phase terminals are assigned in 

the next row, which a given circuit is connected to. The next step is to define parameters for a given 

circuit: 

- voltage 

- phase design 

- installed power 

- simultaneity factor 

- power factor 

Type and parameters of the conductor are defined in the lower section of the window. 

3.2.2 Power supply rails  

When rails are "double-clicked" or selected on the diagram and properties dialogue box is entered, the 

window is open, in which a network layout can be specified by defining the phase design: 

 

- 3P+N+PE  (TN-S layout) 

- 3P+N   (TT layout) 

- 3P+PEN  (TN-C layout) 

- 1P+N+PE  (TN-S layout) 

- 3P   (IT layout) 

The rail properties window: 
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Rys. 9. The distribution board properties window 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

The designer defines rails type, their material and dimensions.  

3.2.3 Connection line 

When the  icon is selected, you can create connections between devices and rails. A node (terminal) 

is created on the ends of the created lines (connection points). The drawing of electrical connection is 

assisted by the item tracking function.  

 

The item tracking can be used to draw electrical connections and maintain right angles.  
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In order to change automatically created lines into user-created lines, the "Explode" function must be 

used: 

 

3.2.4  Breaker switch 

When the  icon is selected and the properties dialogue box is entered, a circuit breaker for the 

diagram can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

 

Rys. 10. The circuit breaker properties window 
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First, a switch breaker symbol is set and circuit breaker database is created in the edit fields. The 

following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

Description – the user can define contents of the description displayed by the item. 

 

A name for a circuit breaker is given in the "name" field, e.g. DPX160, S303, P320 

 

Next, the user selects equipment for the circuit-breaker:  

- a number of auxiliary contacts (normally open contacts, normally closed contacts)  

- shunt trip – responds to voltage increase,  

- undervoltage trip – responds to voltage drop,  

- motor drive – used to control the circuit breaker,  

- differential current protection – (defining the residual current of the unit), 

 

The following circuit-breaker types are available: 

 power, 

 overcurrent, 

 differential current, 

 differential current with overcurrent protection, 

 motor, 

 air-break, 

 limit.  

 

The user then defines type parameters, such as: 

 a number of poles (depending on the phase design of the circuit) 

 rated current of the circuit-breaker – current that may flow through the circuit-breaker for a long time  

 short-circuit making capacity – the maximum short-circuit current a given device withstands 

 characteristics of an overcurrent protection for residual current circuit breakers 

 characteristics of a residual current protection and residual current for residual current circuit breakers 

 nominal voltage for limit circuit breakers  



ArCADia-DISTRIBUTION BOARDS User Manual 

Working with the software 

 

26 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

The defined device can be saved by clicking the "Save in template" button.  

When a next circuit-breaker is selected, (by clicking the  icon), all settings of the saved device are 

given. 
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3.2.5 Surge arrester  

When the  icon is selected and the properties dialogue box is entered, an arrester for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item.  

 

Rys. 11. The arrester properties window 

 

First, an arrester symbol is set and arrester database is created in the edit fields.  

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

Description – the user can define contents of the description displayed by the item. 

 

A name for an arrester is given in the "name" field, e.g. DehnGuard. 

 

The user defines class, a number of poles and protection degree Up for the arrester.  
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Class B (type 1) – the first protection degree. They allow the current in the form of 10/350 µs to be 

discharged to the ground, the closest in its characteristics to surge currents.  

 

Class C (type 2) – the second protection degree. They allow the current in the form of a wave 8/20 µs 

to be discharged to the ground, the closest in its characteristic to current wave due to direct lightning 

strike effects. Used inside of a system with a main switchgear.  

 

Class D (type 3) – used for terminal protection by a protected device. 

 

Protection level Up – a voltage value, which occurs in a surge arrester and which voltage is brought 

down to in a protected device. 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. 

When the view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard 

installation type. The user can define device dimensions or use the material 

database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 
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The defined device can be saved by clicking the "Save in template" button.  

When a next arrester is selected, (by clicking the  icon), all settings of the saved device are given. 

3.2.6 Load switch  

When the  icon is selected and the properties dialogue box is entered, a load switch for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item.  

 

Rys. 12. The load switch properties window 

First, a load switch symbol is set and load switch database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 
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Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

Next, the user selects equipment for the load switches:  

- a number of auxiliary contacts (normally open contacts, normally closed contacts)  

- shunt trip – responds to voltage increase,  

- undervoltage trip – responds to voltage drop, 

 

A name for a load switch is given in the "name" field, e.g. RBK00, VISTOP, FR303 

 

The following load switch types are available: 

 Isolating modular, 

 Isolating, 

 Air-break, 

 Fused, 

 Fused strip 

 

The user then defines type parameters, such as: 

 a number of poles (depending on the phase design of the circuit) 

 rated current of the load switch – current that may flow through the load switch for a long time  

 short-circuit making capacity – the maximum short-circuit current a given device withstands 

 the following is defined for fused load switches: 

- type of a fuse link: WT, D0, cylindrical 

- rated current of a fuse link 

- Characteristics of a link 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

 - Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. 

When the view is generated, it will be located on the TH35 rail. 
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- dimensional:  means that a device has non-standard dimensions and non-standard 

installation type. The user can define device dimensions or use the 

material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next load switch is selected, (by clicking the  icon), all settings of the saved device are given. 
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3.2.7 Contactor  

When the  icon is selected and the properties dialogue box is entered, a contactor for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 13. The contactor properties window 

First, a contactor symbol is set and contactor database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 
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Next, the user selects equipment for the contactors:  

- a number of auxiliary contacts (normally open contacts, normally closed contacts)  

 

A name for a contactor is given in the "name" field, e.g. SM303, A63 

 

The user then defines type parameters, such as: 

 main contacts (these are the main current circuits of a contactor): r – normally closed contacts, z – normally 

opened contacts 

 a number of poles  

 rated current of the contactor – current that may flow through the contactor for a long time  

 short-circuit making capacity – the maximum short-circuit current a given device withstands 

 contactor coil voltage  

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. 

When the view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard 

installation type. The user can define device dimensions or use the material 

database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  
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The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next contactor is selected, (by clicking the  icon), all settings of the saved device are given. 

3.2.8 Switch  

 

When the  icon is selected and the properties dialogue box is entered, a switch for the diagram can 

be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 14. The switch properties window 

First, a switch symbol is set and switch database is created in the edit fields.  
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The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

Next, the user must define switch contact types (z – normally open contact, r – normally closed 

contact, z/r – no/nc contact). 

 

Next, a name is given to the switch in the "name" field, e.g. ŁK16 and rated current, contact types are 

specified for the switch. 

The following switch types are available: 

 manual, 

 manual push-button, 

 cam, 

 isolating, 

 normally open contact, 

 normally closed contact, 

 NO/NC contact. 

 

In case of cam switches, the user defines a position of a given switch and a number of individual 

contacts: 
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Rys. 15. The cam switch properties window 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When 

the view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard 

installation type. The user can define device dimensions or use the material 

database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 
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At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next switch is selected, (by clicking the  icon), all settings of the saved device are given. 

3.2.9 Programmer 

When the  icon is selected and the properties dialogue box is entered, a programmer for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 16. The programmer properties window 

 

First, a programmer symbol is set and programmer database is created in the edit fields.   



ArCADia-DISTRIBUTION BOARDS User Manual 

Working with the software 

 

38 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a relay is given in the "name" field, e.g. PM325, CRP 

 

Contact types – the designer defines a current contact type for the programmer. 

 

The designer has four programmers to choose from: 

- twilight – used to control outdoor lighting, 

- time – used to control consumers depending on a day and hour, 

- astronomical – used to control road lighting, 

- thermostatic – used to control heating, 

Rated current – rated current of the programmer contact. 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- module:  means that a device has dimensions defined by a number of modules. It will 

be located on the TH35 bus. 

- dimensioned:  means that a device has non-standard dimensions and non-standard 

installation type. The user can define device dimensions or use the material 

database. 

- on door:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 
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At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

The defined device can be saved by clicking the "Save in template" button.  

When a next programmer is selected, (by clicking the  icon), all settings of the saved device are 

given. 

3.2.10 Relay 

When the  icon is selected and the properties dialogue box is entered, a relay for the diagram can 

be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 17. The relay properties window. 
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First, a relay symbol is set and relay database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a relay is given in the "name" field, e.g. P16. 

The designer has four relays to choose from: 

 

- toggle – used to control lighting in circulation routes.  

- time – used in automation systems. 

- 1-f phase control – used to signal presence of voltage in 1-f circuits  

- 3-f phase control – used to signal presence of voltage in 3-f circuits 

- voltage coil – an integral part of a relay. The user can assign a relay address to a coil to create 

control diagrams. 

 

The designer can specify a function of a time relay and voltage coil:  

- with delayed action,  

- with delayed closing, 

The designer specifies a type a number of relay contacts: 

- 1z-4z (normally open contacts) 

- 1r-4r (normally closed contacts) 

- 1z/r-4z/r (NO/NC contacts) 
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Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. It will be 

located on the TH35 bus. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- on door:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next relay is selected, (by clicking the  icon), all settings of the saved device are given. 
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3.2.11 Controller 

When the  icon is selected and the properties dialogue box is entered, a controller for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 18. The controller properties window. 

First, a controller symbol is set and controller database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a controller is given in the "name" field, e.g. AC500. 

Voltage – power supply voltage of a controller.  



ArCADia-DISTRIBUTION BOARDS User Manual 

Working with the software 

 

43 

 

Number of input signals – input signals from sensors, e.g. motion detectors. 

Number of output signals – 0/1 output signals from a controller  

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. It will be 

located on the TH35 bus. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next controller is selected, (by clicking the  icon), all settings of the saved device are given. 
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3.2.12 Transformer 

When the  icon is selected and the properties dialogue box is entered, a controller for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 19. The transformer properties window. 

First, a transformer symbol is set and transformer database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a transformer is given in the "name" field, e.g. TR2.  
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Next, the designer specifies a transformer type: 

- safety – transformer reduces voltage to voltage level  

- separation – transformer with the voltage ratio of 1. It has a galvanic isolation between the primary 

and secondary winding. It is used as one of the forms of protection against electric shock. 

 

The user then defines type parameters, such as: 

 Primary voltage (voltage of the transformer primary side)  

 Secondary voltage (voltage of the transformer secondary side) 

 Transformer power.  

 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- on door:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 
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An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next transformer is selected, (by clicking the  icon), all settings of the saved device are given. 

3.2.13 Power supply 

When the  icon is selected and the properties dialogue box is entered, a power supply for the 

diagram can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 20. The power supply properties window. 

First, a power supply symbol is set and power supply database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 
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Description – the user can define contents of the description displayed by the item. 

A name for a power supply is given in the "name" field, e.g. DR-15.  

The user then defines type parameters, such as: 

 Input voltage of a power supply  

 Output voltage of a power supply 

 Power of a power supply 

 Rated current of the output. 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When 

the view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard 

installation type. The user can define device dimensions or use the material 

database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database.   

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

The defined device can be saved by clicking the "Save in template" button.  

When a next power supply is selected, (by clicking the  icon), all settings of the saved device are 

given. 
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3.2.14 Sensor 

When the  icon is selected and the properties dialogue box is entered, a sensor for the diagram can 

be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 21. The sensor properties window. 

First, a sensor symbol is set and sensor database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 
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The designer can choose auxiliary contacts for a sensor (normally open, normally closed). 

 

A name for a sensor is given in the "name" field, e.g. CR17  

The user then defines sensor parameters: 

 motion sensor 

 flood protection sensor 

 smoke detector 

 photosensor 

 light intensity detector 

 temperature 

 capacity sensor 

 gas detector 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- on door:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 
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The defined device can be saved by clicking the "Save in template" button.  

When a next sensor is selected, (by clicking the  icon), all settings of the saved device are given. 

3.2.15 Signalisation 

When the  icon is selected and the properties dialogue box is entered, a signalling item for the 

diagram can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 22. The signalisation properties window. 

First, a symbol is set for an item and signalling database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 
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Description – the user can define contents of the description displayed by the item. 

 

A name for a sensor is given in the "name" field, e.g. CR17  

Next, the user defines rated voltage of the power supply and phase design of the consumer and 

signalling type: 

 bell 

 lamp 

 buzzer 

 bell transformer 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next signalling device is selected, (by clicking the  icon), all settings of the saved device are 

given. 
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3.2.16 Socket 

When the  icon is selected and the properties dialogue box is entered, a socket for the diagram can 

be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 23. The socket properties window. 

 

First, a socket symbol is set and socket type database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a socket is given in the "name" field, e.g. GN2  



ArCADia-DISTRIBUTION BOARDS User Manual 

Working with the software 

 

53 

  

 

Next, the user defines a type (modular, industrial) and a socket type: 

-2P+Z 

-3P+Z 

-3P+N+Z 

-2P 

 

Rated current of the socket – the maximum current, which may flow through the socket for a long 

time. 

Voltage – rated voltage of the socket [V]. 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

The defined device can be saved by clicking the "Save in template" button.  

When a next socket is selected, (by clicking the  icon), all settings of the saved device are given.  
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3.2.17 Electricity meter 

When the  icon is selected and the properties dialogue box is entered, a meter for the diagram can 

be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 24. The meter properties window 

First, a meter symbol is set and meter type database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a meter is given in the "name" field, e.g. SC8  
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Base current – specifies a current value, at which a percentage measurement error is close to zero. 

 

Maximum current – the maximum current, with which an electrical energy meter can be loaded. . 

Voltage – rated voltage of a power supply of the meter. 

Phase design – phase design of the meter. 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

The defined device can be saved by clicking the "Save in template" button.  

When a next meter is selected, (by clicking the  icon), all settings of the saved device are given.  
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3.2.18 Current transformer 

When the  icon is selected and the properties dialogue box is entered, a current transformer for the 

diagram can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 25. The current transformer properties window. 

First, a current transformer symbol is set and current transformer type database is created in the edit 

fields.  

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a current transformer is given in the "name" field, e.g. IMW.  
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Primary current – specifies a value of current flowing in the primary winding. 

Secondary current – specifies a value of current flowing in the secondary winding. 

 

Rated power – is referenced to the rated secondary current I2N and corresponds to such a load Z at cos 

φ = 0.8 ind., at which errors are within limits of a given accuracy class. 

 

Phase design – phase design of the transformer. Specifies a number of transformers installed in the 

circuit. 

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- on door:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

The defined device can be saved by clicking the "Save in template" button.  

When a next current transformer is selected, (by clicking the  icon), all settings of the saved device 

are given.  
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3.2.19 Voltmeter 

When the  icon is selected and the properties dialogue box is entered, a voltmeter for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 26. The voltmeter properties window. 

First, a voltmeter symbol is set and voltmeter type database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for a voltmeter is given in the "name" field, e.g. V2.  

Phase design – phase design of the voltmeter. Specifies whether a measurement refers to phase 

voltage or phase-to-phase voltage. 
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Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next voltmeter is selected, (by clicking the  icon), all settings of the saved device are given.  
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3.2.20 Ammeter 

When the  icon is selected and the properties dialogue box is entered, an ammeter for the diagram 

can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 27. The ammeter properties window. 

First, an ammeter symbol is set and ammeter type database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for an ammeter is given in the "name" field, e.g. A12. 

  



ArCADia-DISTRIBUTION BOARDS User Manual 

Working with the software 

 

61 

Phase design – phase design of the ammeter. Specifies whether a measurement refers to phase 

current or phase-to-phase current. 

Current rating range – the maximum current, which an ammeter can measure.  

 

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular: means that a device has dimensions defined by a number of modules. When the view 

is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

 The device front side is defined by the user for a dimensional or door-mounted 

installation. 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next ammeter is selected, (by clicking the  icon), all settings of the saved device are given.  
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3.2.21 Network analyser 

When the  icon is selected and the properties dialogue box is entered, a network analyser for the 

diagram can be defined. The properties dialogue box is opened by double-clicking an inserted item:  

 

Rys. 28. The network analyser properties window. 

First, an analyser symbol is set and analyser type database is created in the edit fields.  

 

The following features can be defined in the "appearance" field: 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Description – the user can define contents of the description displayed by the item. 

 

A name for an analyser is given in the "name" field, e.g. AST. 
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Phase design – a phase design of the analyser specifies whether network parameters are measured in 

one or three phases. 

 

Current rating range – the maximum current, which can be parameterised by the network analyser.  

Next, the user defines parameters that will be used to generate the real view of a device, that is: 

- Installation type: 

- modular:  means that a device has dimensions defined by a number of modules. When the 

view is generated, it will be located on the TH35 rail. 

- dimensional:  means that a device has non-standard dimensions and non-standard installation 

type. The user can define device dimensions or use the material database. 

- for doors:  means that a given device is door-mounted. The user can define device 

dimensions or use the material database. 

 

Number of modules – the user defines a number of modules that make up a given device. 

Dimensions – the user defines dimensions (height x width x depth) of a single module for modular 

installation. 

The device front side is defined by the user for a dimensional or door-mounted 

installation. 

 

At the very bottom of the window, the user defines a connecting method for connections on the 

diagram. 

When the "connect automatically" checkbox is clicked, an item is automatically connected with phase 

rails and PE terminal.  

The user can make custom connections (individual) using the "connection line" item. 

 

An item can be inserted in any location of the diagram fields by selecting and dragging an item.  

When the automatic connections are switched on, an item is located in the middle of the diagram cell. 

 

The defined device can be saved by clicking the "Save in template" button.  

When a next network analyser is selected, (by clicking the  icon), all settings of the saved device are 

given.  
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3.2.22 Insert material list 

After clicking the  icon a table with a list of all the elements of the designed distribution board is 

displayed, which you can insert into the drawing by clicking the mouse on the screen.  

The table contains a list of all the devices, names, markings and quantities of the items used in the 

particular project. 

Double-clicking a table inserted into the drawing opens the item properties window. 

 

Rys. 29. The material list properties window 

In the table the user defines the visual parameters of the table [pens, fonts] and its contents, i.e. "Used 

Components" box show elements to be displayed in the table (name, unit, quantity). 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 
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3.2.23 Generation of lists 

ArCADia-Switchboards enables to generate lists of materials used in the design. The software saves 

the list in RTF format, which can be opened in any version of MS Word and OpenOffice.  

Once the  icon is clicked, a "Save report/list" dialogue box appears from the bar. This box is used to 

select the location where the generated lists will be saved on the hard drive. In order to preview the 

saved file you need to locate the path and open the file by double-clicking it. 

 

Rys. 30. Save report/list dialogue box 


